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LIMac

Join the crowd: the annual membership 
drive for 2001 is now under way.
Your $26 dues check may be brought to the 
meeting or mailed to:
Long Island Mac Users Group
P.O. Box 518
Seaford, NY 11783 0

We had battery-
operated holiday 
lights too! We hung 
them on the original 
128K Mac used at 
our early meetings, 
but our guest 
speaker last month, 
Andy Ihnatko, told 
us how he used the 
lights as a hat decora-
tion, and then as a 

true “geek” he modified and improved the 
display in subsequent years! This was only 
one of the many interesting topics covered by 
Andy, and we’re glad he was able to come 
down from Boston to speak to us. 
Thanks, Andy!0
 –Donald Hennessy

Most Mac users are familiar 
with Adobe Type Manager (ATM), 
the Control Panel required to 
smoothly render a wide selection 

of Postscript Type 1 fonts on screen, on non-
Postscript printers and faxmodems. Desktop 
publishers regularly may juggle hundreds if 
not thousands of typefaces. It is not practical 
for speed and maximum number of open 
files reasons to have every font available all 
the time, which leads to the need for a 
font management solution. Previous solutions 
were MasterJuggler and Suitcase, but the most 
functional at this time is Adobe Type Manager 
Deluxe. 

For some reason, the proper handling 
of fonts seems to allude most people. ATM 
Deluxe can check your fonts for damage that 
can cause your Mac to crash or have printing 
problems  – and can scan for duplicates to keep 
your collection in order. It can turn on and 
off TrueType and Postscript fonts in sets and 
auto-activate required fonts in any program. 

Bradley Dichter will take us through a 
common scenario of controlling fonts. 0

Friday, March 9th, 7p.m., Anna Rubin Hall 
(Building 300), The New York 
Institute of Technology, Old Westbury. 

The Internet SIG: Held at the Bethpage Public Library (516-735-4113) on 
Monday, March 19th, at 8 p.m.
Beginners SIG: We will continue our discussion of formatting and use of 
fonts in Appleworks documents. Begins at 7:45.
Mutimedia SIG: Will meet at Bernie Flicker’s place of business (ABC 
Industries, 100 Cleveland Ave., Freeport, NY) on the third Monday of each 
month at 7:00 starting February 26th. Call Bernie for driving instructions 9 to 
5 any day at 516–867-8400, ext. 325. 
SIGs immediately after the general meeting:
Mac Help SIG: MacHelp SIG will be on vacation this month
DTP/Photoshop SIG: Richard shows his many tricks of the trade.
The new meeting room and date will give us access to necessary equipment 

and extended meeting time to pro-
duce a video, with the raw footage 
already collected, about LIMac
x LIMac meetings, unless otherwise 
noted, are held in Building 300 
(Anna Rubin Hall) at the New York 
Institute of Technol ogy on Northern 
Blvd. in Old Westbury. 
| In bad weather, call 516-686-7789.
| The next LIMac board meeting 
will be at the Plainedge Library 
(516-931-3907) on Wednesday, 
March 14th, at 8 p.m.

Help!
The User Group Network 
is in need of a few good 
volunteers who like to surf 
the Web and can help out 
with some specific short-term 

projects in the shareware and/or resources 
departments of their Web site.

The pay is very low, (books, software, 
T-shirts, freebies) but the rewards of accom-
plishment and User Group community esteem 
is very high.

If you’re interested, please contact UGN 
either at the site www.user-groups.net/, or to 
showker@ user-groups.net. 0
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Technical CornerPresident’s Message

Bradley Dichter
bdichter@cdr.net

Bill Medlow
President
ArchBill@aol.com

| I have a DVD player on my iMac. After 
ten minutes, the sound becomes out of 
sync with video. What can I do to correct 
that?
Update using the Software Update control 
panel. You need Mac OS 9.0.4 and DVD Player 
2.2, among other things available from Apple, 
to improve the software decoding of DVD 
movies.
| I have copies of the same plug-ins with 
Internet Explorer and Netscape Communi-
cator and there is a copy in the System 
Folder. Can I remove them from all but 
one location and the applications will find 
them?
No. They are not shared libraries that would 
go in the System Folder > Extensions folder. 
There has to be a item in the Plug-ins folders. 
If you wish to save the small amount of disk 
space, you can leave one copy in, say, the 
Plug-ins  folder of Communicator and put an 
alias of each master plug-in in the Plug-ins  
folder of Internet Explorer. The spare copy of 
the Quicktime Plug-ins  in the System Folder 
> Internet Plug-Ins folder are there in case you 
need to find a copy for a new application. The 
suggestion from Apple is if QuickTime gets 
updated, aliases to these master copies will 
resolve to the newer replacements. Too bad 
more plug-ins don’t rely on aliases to master 
copies in the System Folder. Real Player uses 
this scheme in general.
| What about the Default Plug-in? Each 
browser has one. Can I use an alias system 
here, too?
No. The Default Plug-in does not handle 
any mime-types, so you might think it’s not 
needed, but leave them alone. Each browser 
expects it’s default plug-in where it is and 
Explorer ’s Default Plug-in is different than 
Communicator ’s. There are different versions 
of the Default Plug-in for different versions of 
each browser. In summary, leave them alone.
| When I installed the updated Internet 
Explorer 5 that comes with Microsoft Office 
2001, I compared the plug-ins of the new 
with the old and found the old release had 
a newer copy. What’s up with this?
Don’t look at modification dates, they can 
mislead you, since the files get modified all 
the time. You should in all cases, give higher 
version numbers higher priority to newer 
modification dates. I change the default list 
view preferences (in the Finder > Edit menu, 

Miscelleneous Stuff
From Extensis: “Development efforts on 
PhotoGraphics has been discontinued due to 
declining interest from our customers and a major 
incompatibility introduced with Mac OS 9.1. For 
these reasons, we have decided to cease selling 
this product. Technical support will still be avail-
able though September 1, 2001. In light of this, 
there will be no further updates to the product.”
✒

From Scott Randell: “When using Microsoft Word 
’98, with some Epson Ink Jet printers, the Office 
Clip Art (clip art that comes with Word and the 
Office Suite) it will print in black and white instead 
of color. I tried a few things but nothing fixed it. 
Looking a Microsoft’s Mac page, I discovered that 
this is a known problem. The workaround for it is 
to include some other colored object such as text, 
a line or a drawing object on the page. You can 
hide text behind the clip art or draw a small line 

the same color as the clip art. You can place the 
line on the picture and you it will blend in perfectly. 
The color palate will provide you will enough colors 
to match the Office Clip Art. Using either of these 
methods will allow the Clip Art to print in the 
proper colors.”
✒
From Arthur Cosonas, LIMAC member: “I would 
like to offer for sale my ALPS color printer/scanner, 
Model MD4000, purchased through LIMac about 

two years ago. The unit has been used very little 
– I have been using my Apple Stylewriter for most 
of my printing chores. The printer has all the 
manuals, accessories, cables, storage box. I’m 
asking  $100.00 or best offer. (516)938-9513 or 
FAX (516)938-1523.” 
✒
Type 2 error on a Macintosh: A Type 2 error on 
the Macintosh operating system is usually related 
to the Mac’s use of its memory. In many cases, it is 

 TIP!
Freehand 8 : 
Save some steps: 
| To edit an existing 
text or object style 
quickly, hold Option 
and single-click the 
style. The Object 
Toolbar switches to 
Text. 
| To quickly open text 
in the Text Editor, hold 
Option and double-
click the text with the 
Arrow tool. 
| Hold Shift while 
bringing colors in from 
a library to select 
more than one at a 
time.
Don’t waste your 
time: 
| Use the Freeform 
tool to reshape paths 
without manipulating 
or creating individual 
points of an object. 
For document, selec-
tion, or pagewide 
removals or changes:
| Edit > Find and 
Replace dialog box.
| To eliminate all over-
printing, select Find & 
Replace > Remove > 
Overprinting.  
| Check for EPS fi les 
that were lost when 
a clipping path was 
moved but the image 
stayed put: Select > 
Object Type > EPS > 
Find. 

Adobe Acrobat 4.0x 
Reader — which 
version do I have? 
Admittedly, Adobe has 
confused the issue. 
After Acrobat 4.0 was 
released with a few 
obvious bugs — or, 
shall we say, issues — 
and without the Mac 
plug-ins that would 
make the software 
work exactly the same 
on a Mac as it does 
on a Windows-based 
PC, Acrobat users 
were on the edge 
of their seats waiting 
for the 4.05 update. 
But Adobe used dif-
ferent version num-
bers for that update, 
which means that 
some people got 4.05, 
others received 4.05a, 
and still others saw 
4.06 on their update 
CDs. According to 
Adobe, however, all 
three version 
numbers represent 
the same update. So 
if you’re using 4.05 
and your next-cube 
neighbor says she has 
4.06, relax — she 
hasn’t got something 
you’re missing out on.

Last November, Olympus 
made a great presentation to 
our group. One of the items 
Desmond Lee showed was 

the C3030 Zoom. I was looking for a digital 
camera, so I tested the C3030 and found that 
Olympus has destroyed the stigma that digital 
cameras are complicated point-and-shoot 
cameras that devour batteries.

This 3.34 Megapixel camera cannot only 
provide an incredibly sharp picture, but it can 
give you many functions like the best auto 
focus SLRs. For example: autofocus, manual 
focus down to eight inches, wireless remote, 
shutter and aperture priority, auto bracketing, 
a range of speeds from 16 seconds to 1/800 of 
a second, zoom from 32mm to 96mm, digital 
telephoto, etc.

As a digital camera, it offers options that 
you expect and some that will surprise you. 
Photos can be saved as TIFFs or JPEGs in 
fifteen different resolutions, compressed and 
uncompressed as well as QuickTime movies, 
panoramas and sound. The camera has a 
32Meg buffer and images can be saved on a 
smart card or downloaded by USB, serial or 
Flash path with a PCMCIA adapter. Olympus 
also provides Macintosh software to handle 
and store  the images as well as Photoshop LE. 
You can set the camera for Black and White 
or Sepiatone images and the ISOs from 100 
up to 400.

The last point I would like to make  is 
in reference to the batteries. While regular 
AA batteries last for a number of sessions, the 
rechargeable batteries that Olympus provides 
last an incredibly long time. Unfortunately, 
the recharger is extra.

Yes, this reads like a review, but I could 
not help myself in wanting to share all this 
with those members who were unable to 
make
the meeting. Affordable digital cameras have
turned the corner; they are truly a break-
through system for the photographer/
computer enthusiast and most important, this 
camera/system is very Macintosh friendly. 0

DON’T FORGET TO PAY YOUR 
DUES FOR 2001. YOU’LL WANT 
TO BE INCLUDED IN ALL THE 
GREAT LIMAC MEETINGS AND 
BENEFITS COMING UP!

 TIP!
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Preferences…) to include the version column 
and often move it’s column to the left as it’s 
more important than the modification date.
| I’m going to install Mac OS 9.1 on a 
Beige G3, with Mac OS 8.1 on one partition, 
9.1 will be on a second partition. Do I have 
to reinstall my applications?
No, just populate the Mac OS 9.1 System 
Folder with copies of all the updated 
non-Apple Extensions, Control Panels and 
Preferences from the Mac OS 8.1 System Folder 
on the other partition. The selection in the 
Startup Disk Control Panel will be unclear, 
since all partitions will be highlighted, but it 
should still work as expected. Totally separate 
drives would be better for clarity here. The 
applications will find their preferences in the 
active System Folder and should be happy. 
There are a few programs that won’t work if 
they are not on the Startup Partition, so you 
may have to have a couple of duplicates. Also 
some updaters will only look on the Startup 
Partition, so keep that in mind when you get 
a mysterious message trying to update some-
thing not on the current Startup Partition.
| I wanted to let everybody know about 
the Bug of the Day Web site. There 
are a bunch of useful warnings there, 
but most of the references are not Mac 
OS related. It’s at www.msnbc.com/news/
bugoftheday_front.asp.
| Whenever I start up Virtual PC 4.0.1, it 
dials my ISP. VPC uses the shared IP of my 
Mac. How can I stop this behavior?
Windows is trying to connect to the Internet 
at startup. Your Remote Access Control Panel 
is set to establish a connection when any 
TCP/IP using program starts. Normally, this 
is a useful shortcut for when you double-click 
on a Web browser or e-mail program, but 
it may be best to turn this option off and 
connect manually. I find that a manual con-
nection is more reliable than one initiated by 
an application launch.
| With a PCI-equipped Mac, can I use any 
PCI card under Virtual PC ?
No. Any card installed must be Mac compat-
ible. Virtual PC has very limited hardware 
support, mostly USB support. The emulation 
cannot be extended by any PCI card. There is 
no emulation for a PCI bridge chip nor any 
PCI slots.
| In Excel 4.0 and other programs on 
Performa 6200CD with Mac OS 8.0, Page 

Setup doesn’t hold it’s settings. What do 
you suggest?
Updating your software including your Mac 
OS and printing software. Excel 5.0a or newer 
is recommended, but your Mac is too slow 
for the only currently available option of Excel 
2001. You may need a consultant to help find 
a proper balance of discontinued but not too 
old software.
| I have an iMac with Mac OS 8.1. Netscape 
keeps reporting my certificate of authority 
has expired. I tried getting Netscape 6.
Don’t bother with version 6, use version 4.7.6. 
It’s easiest to get from our Web site, on the 
Internet Connection Kit page. It can be hard to 
find it on Netscape’s Web site.
| I have a Power Mac 7300/180 running 
Mac OS 8.6 on Ethernet network. Pulling 
files from another Mac locks up the Mac. 
If another computer sends files to this 
computer it works OK. I have checked for 
viruses. How can I fix this?
Try disabling the virus protection to see if it’s 
causing the lock-up as it may be checking the 
new files for infections. Make sure you don’t 
have the old Ethernet (built-in) Extension 
as well as the newer Apple Enet Extension. 
I’ve seen this on some Macs that have 
been upgraded improperly. Also try disabling 
RAMDoubler if you have it. Try using the 
Mac OS 8.6 All Set in the Extensions Manager 
Control Panel. If it works under this test, the 
commercial Conflict Catcher is very useful in 
helping figure which Extension or Control 
Panel is causing the problem. A conflict test 
would require a bunch of restarts and trial file 
transfers to identify the troublemaker.
| I have a Performa 6300 with 128M RAM. 
I want to take advantage of iTools. Can I 
install Mac OS 9 ?
You can run Mac OS 9, but you will find it 
will run much slower and the internal Express 
modem in the 6300 won’t work, so you’ll have 
to buy and external modem for Internet access. 
Also you will probably need to update every-
thing else on the computer to work with Mac 
OS 9. Some items never were updated. 0

 TIP!  TIP!

because the computer tries to store a bit of data 
from the program you are using into a section of. 
its memory that cannot hold ft. When this data is 
rejected, it can cause the program to crash.
Although the program crash may not immediately 
cause your whole system to crash, restarting 
is always a good idea. It resets the machine’s 
memory and returns the system to normal.

If you can still move your mouse, you can 
restart the Mac from the Special menu. If your 

mouse has frozen, press the small button with 
a tiny triangle on it, located on the front of 
most recent Mac models; on the Imac, the 
reset button is on the right side near the cable 
ports.

Type 2 errors can be caused by Macintosh 
Extension and Control Panel conflicts or pro-
cessor problems, but a common cause is 
insufficient memory. One way to try to stop the 
Type 2 errors is to give the crashing program 

more of the System’s memory.
To increase the memory allocated to a par-

ticular program on your Mac, quit the program 
(if it is open) and find the program’s original 
icon on your Hard Drive. Click once on it to 
select it, then go to the File menu to Get 
Info. Click on the pop-up menu under General 
Information and select Memory from the list.

You will see a suggested, size for memory 
allocation listed, as well as places where 

yqu can type in new amounts for the pro-
gram’s minimum and preferred RAM allot-
ments. Increasing the numbers here to higher 
amounts than the suggested memory size will, 
assign more RAM to the program.

If you use the Mac’s Virtual Memory 
Control Panel to simulate actual RAM, try 
increasing the amount of space devoted to 
Virtual Memory. 0

– J.D. Biersdorfer 

Aladdin Systems is 
offering LIMac mem-
bers the opportunity 
to purchase surplus 
copies of Aladdin soft-
ware at extremely low 
prices. 

The following 
Aladdin products 
are on clearance: 
IntelliNews 2.0 $4.95,
MacTicker 1.6.1 
$4.95, Sundial 
California 2.0 and 
Sundial Hawaii 2.0 
both $9.95, Aladdin 
FlashBack 1.1 $9.95, 
ShrinkWrap 3.5.1 
$19.95

These prices are 
only available via 
the Special User 
Group Clearance 
Sale Order Form. 
You won’t find these 
deals anywhere else. 
Go to: www.alad 
dinsys.com/support/
user groups and 
look for the UG 
Clearance Sale 
Order Form link. 

The sale ends 
April 30, 2001, or 
until supplies last, 
so make sure to act 
quickly!

The pricing on 
the UG Store 
www.alad dinsys. 
com/support/
usergroups/ugvalid. 
html is their every- 
day, low user group 
pricing. You will find 
special pricing on 
their most recently 
released software, 
like StuffIt Deluxe 
6. Use the following 
order codes (if 
you’re not an 
affiliate member) to 
purchase from the 
UG Store: MUG 0201

Illustrator Type to 
Photoshop : 
When you’re moving 
type from Illustrator to 
Photoshop, you’ll get 
the most predictable 
results if you convert 
the type to outlines 
fi rst. Otherwise, you 
may lose kerning of 
letter pairs or 
Photoshop may clip 
ascenders and 
descenders. 

–Design Tools Monthly

Edit Bookmarks and 
Favorites:
In Netscape Navigator 
or Communicator, or 
in Microsoft Internet 
Explorer, you can edit 
the name of a 
Bookmark or Favorite 
(or its URL) by 
selecting it in the 
Bookmarks or 
Favorites palatte and 
pressing Command-I 
(Get Info). In the 
resultant dialog box, 
make your changes to 
the name or address.

 TIP!



Helen and
Sheldon Gross
shel9 @ bellatlantic.net

Sore Eyes

Note: These sites are 
referred to by us for 
your information only 
and neither we nor 
LIMac endorse any of 
the products or sites.

Long Island Macintosh Users Group
Post Office Box 518
Seaford, New York 11783
www.limac.org
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One of the major complaints about search 
engines is the overwhelming number of 
responses to the request most of which are 
irrelevant at best or completely off the mark. 
Frequently, the time it takes to wade through 
this morass is so frustrating that the searcher 
(me) either gives up or gets lost on the trail. 
Help in finding a way out of this maze is here 
now – and more refined search engines are on 
the way. And mysimon.com is here now. 

It is simple to use and covers a huge 
variety of purchases and services from airline 
or travel to credit cards to vacuum cleaners, 
giving comparative prices for each item. Pull 
down menus enable tailoring the search to 
the specifics. Item quality is not rated, but it 
is comparison shopping without getting out 
of your chair. 

Another site, academicinfo.net, is made-to- 
order for students and teachers. Subjects are 
classified to make information very useful 
for lesson plans, term papers or any other 
research project. While the site is still under 
construction with new information, existing 
topics are continuously updated and include 
references to both historical and daily current 
events. 

biolinks.com is a resource search engine 
designed by scientists for scientists and pro-
vides dedicated searches for diseases, up-to- 
date medical information, current research 
projects, and drug development including 
progress in the DNA Biotech sector.

findlaw.com deals with criminal and civil 
law and aids legal scholars, practicing lawyers, 
students, or potential clients. It has precise 
links to constitutional law, bankruptcy, civil 
rights, torts (accident cases), including dog 
bites, falls, autos, libel and slander, etc. 

These sites are definitely a leap forward in 
online research. 0

The following vendor offers are available to 
user group members only:
| The APPLEWORKS JOURNAL, is a 24-page 
newsletter filled with tutorials, tips, projects 
and news for AppleWorks users. Subscriptions 
usually cost $39, but MUG members can 
receive a full year of the AppleWorks Journal 
(10 issues) for only $34. Subscriptions also 
include membership in the AppleWorks Users 
Group (AWUG), which provides free tele-
phone and e-mail technical support, and 
access to AWUG’s Web site with more than 
1,500 AppleWorks templates. To subscribe 
by telephone (888) 781-AWUG, fax (734) 
454-1965, or e-mail at membership @ awug.org. 
| MACHOME JOURNAL has reviews, news 
and updates of the latest hardware and soft-
ware, including current game and education 
reviews. MacHome Journal has a six-month 
MUG subscription offer (not applicable on 
renewals).

6 issues of MACHOME JOURNAL
3 issues of iMAC BUYER’S GUIDE
3 CD ROMs

All for $9.95, plus, a free MUG gift – the 
2001 MacHome Games CD.

Order online at www.machome.com./
mugoffer. Phone 800-6542 and mention MUG 
offer. Good through September 2001.
| Aladdin Systems is having a clearance sale 
on surplus copies of the following software:
IntelliNews 2.0 $4.95
MacTicker 1.6.1 $4.95
Sundial California 2.0 and Sundial Hawaii 2.0  
both for $9.95
Aladdin FlashBack 1.1 $9.95
[For the full details of this offer, see OFFER on 
page two.] 0

A typographic char- 
acter that’s relatively 
unknown but some- 
times is very useful 
is the dotless i (ı) . 
For instance, in some 
script faces the cap-
ital W bumps right 
into the the lower case 
i dot (Wi). In such a 
case, use the dotless 
i to solve the problem. 
Or if you don’t like 
the look of the stan-
dard ligature for fi , try 
the letter f with the 
dotless i (fı). Press 
Option-Shift-B to get 
the character.

–Robin Williams

Max Rechtman
MaxLIMac@aol.com

The General Meeting will 
be Bradley Dichter 
showing how to use 
Adobe’s Type Manager 
Deluxe.

Everyone should use 
a method of controlling 
their fonts. And Bradley 

always recommends ATM Deluxe. Be there to see why, 
as well as hear his popular Q&A segment.

Friday, March 9th, 7p.m., Anna Rubin Hall 
(Building 300), The New York Institute of 
Technology, Old Westbury. 

BRADLEY DICHTER “IN ACTION.


